Applying to Working at Western

Contents
1. About Working at Western ........................................................................................................... 1
2. Registering and login information ............................................................................................... 2
3. My Account Information: updating your personal/contact information ..................................... 2
4. Careers: your starting point for Working at Western ................................................................... 2
   a. View all Jobs .......................................................................................................................... 2
   b. Apply for jobs ....................................................................................................................... 4
   c. Search Jobs .......................................................................................................................... 4
   d. Filter Jobs ............................................................................................................................ 5
   e. Print jobs .............................................................................................................................. 5
5. Using the guided application process ......................................................................................... 6
6. My Job Applications: managing your applications .................................................................... 12
7. My Job Applications: viewing attachments ................................................................................ 13
8. More information about PDF attachments ................................................................................ 13
   a. PDF FAQS ............................................................................................................................ 13
   b. PDF Troubleshooting .......................................................................................................... 13
   c. Creating PDF documents ..................................................................................................... 14
9. Sign out of Working at Western ................................................................................................ 15
10. Tips and FAQs .......................................................................................................................... 15
11. Need assistance? ....................................................................................................................... 17
    Troubleshooting ...................................................................................................................... 17
    Contact us: ............................................................................................................................ 17
12. Our Privacy Statement - read .................................................................................................. 17
13. Western is committed to employment equity .......................................................................... 17
1. About Working at Western

*Working at Western* is our online application system for:
- Staff positions (part-time and full-time)
- Faculty positions (part-time)

Full-time faculty positions can be accessed at [Academic Careers](#). Job opportunities are posted as they become available.

If you do not have access to a computer, you are encouraged to visit us on campus. Computer access and assistance are available in the Human Resources Communication Centre located in the Support Services Building, Room 4159.

Go to *Working at Western* site from [Employment Opportunities](#). Under *Logging In*, select the link that best describes you:

- Current or recent Western employees (worked within last six months) select *I am a current Western employee or I have worked at Western within the past six months* to log into My Human Resources and select *Working at Western*.
- External applicants (have not worked at Western within last six months) select *I do not work at Western and have not worked at Western within the past six months*.

You are now on *Careers* where you may view and apply for jobs. External applicants must register before applying to jobs.
2. Registering and login information

If you are a current or recent Western employee and need assistance with your Western user name or password, please visit our How do I… webpage.

First-time external applicants will select New User or Register Now and create a user name and password. Before registering, you must acknowledge that you have read and agree to the Terms and Conditions.

External applicants who have applied before, should select Sign In and login with the user name and password that was previously created. Select Forgot User Name or Forgot Password if you need assistance.

If you are having difficulty logging in please read the document Having Trouble with Working at Western or My Human Resources?

3. My Account Information: updating your personal/contact information

Current or recent Western employees will login through My Human Resources and select Personal Details.

External applicants will select My Account Information.

Changes to your contact information will be updated on all jobs you have applied to.

4. Careers: your starting point for Working at Western

a. View all Jobs - Select View All Jobs and all currently available positions will list on the Search Jobs page. Drag the scroll bar up and down to view jobs. Each job listing includes the Job Title, Job ID Number and Close Date (the posting will be removed after this date).
To view the posting Job Description, click the arrow (>) at right.

The posting Job Description provides all the details about the position.

Select Add to Favorite Jobs to add this posting to My Favorite Jobs under Careers.
b. **Apply for jobs** – External applicants must register before applying for a job. Open the posting Job Description as described in #4a above. Next, click **Apply for Job**. Read Using the guided application process.

![Apply for Job](image)

b. **Search Jobs** – Use the Search bar at the top of Careers for a quick job search. Type in a key word - e.g. “Clerk” or “Economics” and click the double arrow at right. You can also search on a specific Job ID number.

![Search Jobs](image)

**Search Jobs** will open and list any jobs which match your search criteria. Click **Clear Search** to view all jobs.
d. **Filter Jobs** – On the left panel of Search Jobs use the filter to select which jobs display in the main panel. This feature is very useful when there are many jobs to scroll through. On a mobile device, click the filter icon to open the filter. You can filter by clicking on a link below the following categories:
- Posting Type (faculty, staff, or student)
- Status (Full-time, Part-time, etc.)
- Faculty/Unit
- Employee Group, and
- Job Posted In (year/month).

The number in brackets following the category name indicates how many jobs are currently available.

For example, under **Posting Type** click Faculty to display only faculty postings.

To view jobs within a specific faculty, select a link under **Faculty/Unit**.

Click **Save Search** to save and name your search criteria for future use. You can access **My Saved Searches** from Careers. Jobs that meet your search criteria will display provided the application closing date has not passed. External applicants must register to use the Saved Searches feature.

When done, click **Clear Search** or X to remove the filter(s). On a mobile device, click **Selected Filters** and then click **Clear All** or X to remove the filter(s).

e. **Print jobs** – Open the posting job description and select **File / Print** to use the print feature on your browser. Depending on your browser, you may have better results by copying and pasting the text into a word processing document to print.
5. Using the guided application process

a. **Select the job you wish to apply to**
   - On Search Jobs, click on the job posting details. The posting Job Description will be displayed.
   - Click **Apply for Job**.

b. **Save your application (recommended)**
   - As you move through the steps, your application will automatically save. However, it is good practice to save every ten minutes. **Working at Western** will time out after a period of inactivity. To avoid loss of work, click the **Save as Draft** button. You can also click the menu button at top right and select **Save as Draft**. Your application will be saved in draft status and you can submit at a later time.

c. **Step 1 of 6: Start**
   - Read the **Terms and Conditions**. You must indicate your agreement by checking the box to proceed.

![Application Process Screenshot]

Click **Next** to proceed Step 2.

*Return to Table of Contents*
d. Step 2 of 6: Resume/CV  
   - Click Attach Resume/CV.  
   - Click My Device and choose the file (must be PDF format) you wish to upload. There are do and don’ts for naming your PDF document, please read More Information about PDF Attachments.  
   - Click Upload and wait for the file to upload. Click Done.  
   - Resume Title will be the same as your file name. If you have previously added a file using the same title, a message will display and you need to change the title.

   - Repeat the above steps for Attach Cover Letter.

   - Review the files you uploaded. Click Change Resume or Change Cover Letter to replace a document.  
   - Click Next to proceed to Step 3.
e. **Step 3 of 6: Supporting Attachments (faculty positions and staff research positions)**

*Note: Publications and Presentations are now added as an attachment (previously you typed in this information).*

- Click **Add Attachments**.
- Select the **Attachment Type**.
- Type an **Attachment Title**.
- Click **My Device** and choose the file (must be PDF format) to upload. Read [More Information about PDF Attachments](#).
- Click **Upload** and wait for the file to upload. Click **Done**.
- Click **Use Different Attachment** to replace a document and follow previous steps.
- Click **Done**.

- Click the plus sign + to add additional attachments.
- Follow the previous steps to upload files.
- Click **Next** to proceed to Step 4.
f. Step 4 of 6: Application

The guided process will step you through each section of the application. Complete the following sections to ensure that Western hiring managers can fully review and assess your application:

- Education – indicate **Highest Education Level** from the drop down. Degrees are required if post-secondary education is completed or in progress.
- Work Experience – add your work experience details and address.
- Languages – indicate languages other than English
- Any other relevant sections.
- Complete the questionnaire sections.
- Click **Next** to proceed to Step 5.

---

g. Step 5 of 6: Equity Questionnaire

The collection of equity data is voluntary but providing this data assists Western in meeting its commitments to hiring more indigenous, black, women, persons with disability, and LGBTQS+ faculty and staff.

- Select either the Yes or No Participation Question (mandatory) – By indicating **Yes**, all questions must be answered; however, each question has an “I prefer not to answer” option.
- Complete all Self-identification questions. Selecting **Additional** will require entry in the **Please specify** text box.
NOTE for mobile device users: Step 6 may take a few minutes to load depending upon your device. A processing icon (looks like a wheel) may flash or display. Please be patient and wait until the page finishes loading before proceeding.
h. Step 6 of 6: Review and Submit

- Review your application to ensure you have included all attachments and completed your information accurately.
- Click each section to review.
- Click Modify if you wish to make changes.
- Click Submit when ready to apply. You will receive a confirmation message.
- Not ready to submit? Click Save as Draft.

- Click View Submitted Application to view again.
- Click Careers or click the menu button at top right to select another action such as Sign Out.
6. My Job Applications: managing your applications

From Careers click **My Job Applications** to see a list of all applications and attachments.

- Details for each application display including the status.
- Draft applications show a status of “Not Submitted”.
- My Job Applications show a status of “Submitted”. For example, if you accidentally omitted important information or an attachment.
- If the status is “Not Submitted” and the posting is still active, you can update your application by clicking the arrow at right.
- You cannot change or update an application if the status is “Submitted”. For example, if you accidentally omitted important information or an attachment.
- If the posting is still active, you can reapply to the same job. Go to Careers to select the job and reapply. Only your most recent application will be considered. When reapplying to the same job, it is recommended to withdraw the previous application (see next bullet).
- You can withdraw an application submitted with errors or omissions.
- You can also withdraw an application if you no longer wish to be considered for the position.
- Click **Withdraw** at right.

- Click **Cancel** if you do not wish to go through with this action.
- A message will display if you are no longer able to withdraw an application at this point in time during the review process.
- Otherwise, click **OK** and your application will be removed from the competition and the status will change to “Withdrawn”.

![Screenshot of My Job Applications](image)

Return to Table of Contents
7. My Job Applications: viewing attachments

To view your attachments, go to Careers and select **My Job Applications**.

- You can open and view your resumes/CVs, cover letters and other PDF attachments.
- Note: Adding or removing PDF attachments is completed during the application process. Read [Using the guided application process](#). You are not able to add or delete attachments under **My Job Applications** with the exception of adding references.
- If the University requests references, click on the plus sign + below **My Cover Letters and Attachments**. Under **Attachment Type** click **Reference** and type an Attachment Title. Next, complete the upload steps. **Please note that references are visible on all jobs that you have applied to.**

8. More information about PDF attachments

a. PDF FAQs
   - **Any documents submitted must be uploaded as a PDF file.** Microsoft Word and other formats cannot be uploaded.
   - **The name of your file** must be no more than 64 characters and contain no punctuation. Do not include periods, for example, “mynameresume.pdf” will cause an error. Instead of a period, use “_” underscore e.g. “mynameresume.pdf”.
   - The period in the file extension (.pdf) will be automatically added when you save your file. Do not add a period at the end of your file before saving e.g. “proctorresume.” will save as “proctorresume..pdf” and the extra period will cause an error.
   - I **password protect my PDF file?** - No, we cannot accept password protected files.
   - **How large can my PDF file be?** - Your PDF file should not exceed 15360 KB.
   - **Can I upload other types of files?** - No, at this time we only permit PDF files.

b. PDF Troubleshooting
   - I’m getting the message **“Invalid PDF document detected”** - There are a number of reasons you may receive this message. If your document has been corrupted or is not a true PDF file, the system will reject it and generate this message. Recreate your PDF document and try uploading it again.
   - **Files that contain a virus will also be rejected.** Try recreating your PDF while your virus protection software is running.
   - **Your file may be password protected.** Recreate your PDF document ensuring your document is not password protected.
   - **The name of your file** must be no more than 64 characters and contain no punctuation e.g. periods. See 8.a. above.
c. **Creating PDF documents**
PDF (Portable Document Format) is a file format that retains the formatting you intended. Many recent versions of word processing software, such as Microsoft Word can generate PDF documents. There are also freeware PDF generators available on the internet.

- **How to save your Microsoft Word 2013 Document as a PDF in Windows**
  - Create or open an existing Microsoft Word 2013 document.
  - Click the **File** tab and select **Save as Adobe PDF**. A new window will open at this point.
  - Select the location and folder where the document will be stored.
  - In the **File Name** box, enter a name* for the file, if you haven't already.
  - Click **Save**. For more information, please refer to [office.microsoft.com](http://office.microsoft.com).

- **How to save your Microsoft Word 2010 Document as a PDF in Windows**
  - Create or open an existing Microsoft Word 2010 document.
  - Click the **File** tab and select **Save As**. A new window will open at this point.
  - Select the location and folder where the document will be stored.
  - In the **File Name** box, enter a name* for the file, if you haven't already. In the **Save as Type** list, select **PDF (*.pdf)** from the dropdown.
  - Click **Save**. For more information, please refer to [office.microsoft.com](http://office.microsoft.com).

d. **Scanning Documents** – You may create PDF files by scanning your document. Scanning can create very large files which can cause problems uploading. It is recommended that you scan in grey scale or black and white, rather than colour for best results. You may also want to keep your file to a manageable size by scanning at a lower quality setting.

e. **Viewing PDF documents** - You need Adobe’s Acrobat Reader for Windows or Mac. Click Adobe image on this page to download a free copy if it’s not currently installed on your computer.
9. Sign out of Working at Western

- To sign out of Working at Western click the menu button and click Sign Out.

10. Tips and FAQs

Tips

Stay active and save frequently - You will be logged out after a period of inactivity. To avoid timing out, click the Save as draft button available on each step and from the menu at top right. Read 5b - Save your application.

Navigation - Do not use the Forward or Back arrow buttons on your browser's toolbar. Instead, use the Next and Previous buttons that appear within the application.

Adjust your pop-up blocker settings - The system will notify you if your session is about to time out (this notification does not occur for external applicants). You will have two minutes to click the OK button on this helpful notification window to ensure your session remains active. To adjust your pop-up blocker settings please read the document Having Trouble with Working at Western or My Human Resources?
FAQs

Can I preview an application?  Sorry, there is no option to preview an application.

Will my prior application(s) be available for me to view or use?  You can view your prior applications. You cannot change or update a previously submitted application. When you apply to a new position, information previously submitted will be brought forward. Read My Job Applications: managing your applications.

Who do I address my cover letter to? – Human Resources does not provide hiring manager information as hiring occurs within departments. “Dear Hiring Manager” is an appropriate salutation for any cover letter.

What if there is not enough space to type a position title or program name? - Common acronyms or abbreviations are acceptable.

Should I include references now? - References are only required at an interview stage. Read My Job Applications: viewing attachments to learn how to upload references if requested by Western University.

Will I receive notification if the job vacancy has been filled by another candidate? - We thank all applicants who apply; however, only those selected for an interview will be contacted directly. When the hiring process has fully completed, an email notification will be sent to all applicants. Please note this process may take up to a few months for some job postings.
11. Need assistance?

Troubleshooting

- If you are having difficulty with web pages not loading correctly please read the document Having Trouble with Working at Western or My Human Resources?
- If you are having difficulty with the system, try deleting all "cookies" and temporary files via your browser’s Tools > Options menu.
- Make sure you have only one browser window open while going through the application process. More than one browser open may cause complications in your application session.
- If you did not receive an email when your application was submitted, check your junk mail and ensure your settings allow email from hr-communication@uwo.ca.
- Upside down question marks appear through copy and paste of characters such as bullets, dashes and quotation marks. To prevent these characters from appearing, copy and paste text through a text editor such as Microsoft Notepad. To remove, delete the ¿ and retype the character. Candidates are not penalized for this system formatting error.

Contact us:

For further information or assistance, please use ASK HR to contact Western Human Resources or call 519-661-2194.

12. Our Privacy Statement - read

13. Western is committed to employment equity

Western is committed to employment equity and diversity in the workplace and welcomes applications from women, members of racialized groups/visible minorities, Aboriginal persons, persons with disabilities, persons of any sexual orientation, and persons of any gender identity or gender expression. Western is committed to ensuring that each individual will have genuine, open and unhindered access to employment opportunities.

Accommodations are available for applicants with disabilities throughout the recruitment process. If you require accommodations for interviews or other meetings, please use ASK HR to contact Human Resources or phone 519-661-2194.

Learn more about diversity in the workplace from Western’s Human Rights Office and from our Equity, Diversity and Inclusion website.